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Dreamweaver and Fireworks MX Integration 
Brian Hogan 
 
This tutorial will take you through the necessary steps to create a template-based web 
site using Macromedia Dreamweaver and Macromedia Fireworks.  The new MX 
versions of these products offer almost total integration. 
 
Throughout this tutorial, I’ll be offering some design tips and tricks as well, to help 
leverage the value of these programs. 
 
Before we begin, make sure you have a good understanding of web site design and 
coding, and that you have installed the trial or full versions of both Dreamweaver MX and 
Fireworks MX. 
 
Setting up the programs 
 
Before we begin, you’ll need to do some preliminary setup in both Dreamweaver MX and 
Fireworks MX. 
 
Dreamweaver MX Setup 
 
Go to the Edit menu and choose Preferences.  Select the File Types / Editors 
category and then look for the PNG extension. Make sure that it’s set to open with 
Fireworks. You should see the word (PRIMARY) next to the Fireworks entry. Click OK to 
apply your changes. 
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Go to the Edit menu and choose Preferences.  Select the Launch and Edit tab and 
make sure you set both options to the values shown below. When the values are set, 
click OK to save the changes. 
 

 
Fireworks MX Launch and Edit settings 
 
After you’ve made these changes, you’re ready to begin designing your page. Fireworks 
MX can import a Photoshop 6.0 document, or you can begin designing it all by yourself. 
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Designing your first Fireworks MX web page template 
 
In this example, we will build a simple web page template for an online business. We’ll 
use the Fireworks MX drawing tools to create the page, and then get it ready to work 
with in Dreamweaver. 

 
 
In Fireworks, click on the File menu and 
select New. You’ll be presented with the 
following dialogue box. 
 
This is where you control the height and 
width of your page. The width is more 
important than the height because we’ll 
be making a page template that will 
expand. When you have your width and 
height selected, click OK to allow 
Fireworks to set up your new canvas. 
 

You’ll be presented with the Fireworks interface.  
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Using the square tools and the text tool, we 
want to design a web page that looks 
something like the design at the right.  
These instructions are simply a guide, 
because I assume you are already familiar 
with a design program like Fireworks, 
Illustrator, or Photoshop. 
 
First, select the Square tool  from the 
Vectors section of the tool palette. Next, 
select the Stroke color to nothing  and the 
Fill color to Blue . 
 
Draw the top rectangle area in the canvas. 
 
Next, change the Fill color to Grey and 
draw the sidebar rectangle, again using the figure as your model. 
 
Select the Text  tool in the Vectors section of the tool palette and create the menu 
on the side. Finally, use the same tool to create the banner text. 
 
You should have a simple page created at this point. Let’s now set everything up to do 
simple button rollovers. 
 
Click on the Frames and History tab. This will expand the list of Frames.  We will need 
to make a new frame so that Fireworks can use it to make a rollover.  The concept of a 
Fireworks Simple Rollover is quite simple. The graphic on Frame 1 is displayed until the 
user places the mouse over the section of the page. At that point, the graphic on frame 2 
is substituted. This will become more apparent when we go through the process.  
 
For now, simply duplicate Frame 1 by dragging the name of the frame over the New / 
Duplicate Frame button. . This will create a copy of the frame that we can alter. 
 

Now, select the menu item text area you 
created.  Select all of the text in that area 
and change its color to a different color.  
I’ll use yellow for my example.  
 
We are now set up to begin converting 
these frames to an actual web page 
template, complete with rollovers. 
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Creating the Web Template – Slice and Dice 
 
Macromedia Fireworks MX makes use of a concept often used by web designers called 
“Slice and Dice” where you take a template graphic and cut it up so that it loads faster or 
can be displayed along with HTML.   
 
The tool palette contains a Slice  tool located in the Web section.  Select this tool and 
begin slicing your page, using the example below as a guide. 

 
You’ll notice that some slices are light-
green. These are HTML slices rather 
than Image slices. If you look at the 
properties inspector after you create 
each slice, you can see the options that 
determine the type of slice you create. If 
you choose an Image slice, you’ll be 
presented with options for a hyperlink, 
an ALT tag, a name for your image, and 
the type of image optimization to use. 
 
Below are the options for the first slice. 
 
 
 
 

 
 
It’s a good idea to name each of your slices. It’s also good to enter in the ALT tag 
information too.  When you’ve finished with the process of naming and optimizing your 
slices,  it’s time to apply the rollovers. 
 
Right-click on the slice that contains the HOME menu item. Select Add Simple 
Rollover. The selection has now been converted to a rollover.  Repeat this process for 
the other menu items. 
 
When you are all done, you should save your Fireworks project by clicking File and 
choosing Save.  Remember where you saved this! You will need it later! 
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 Setting up a Site in Dreamweaver 
 
Before you can export your Fireworks page to Dreamweaver, you need to set up a site in 
Dreamweaver.   
 
Click the Site menu and choose New Site.  The following dialogue will appear.  Give 
your site a name and then specify the location of the local folder where all of your files 
should be stored. You can also specify a default images folder, where all of your 
graphics files will be stored.   
 

 
 

When you’ve entered your settings, click OK.  It’s important to allow the Design Notes to 
be turned on, otherwise the integration will not work. 

 
You will now see your site structure defined in the 
Sites palette within Dreamweaver. 
 
Now that your site is defined, it’s time to export the 
Fireworks files to Dreamweaver HTML. 
 



 

Dreamweaver and Fireworks Integration                                                                     Page 7 of 18 
 

Copyright © 2002 Brian P. Hogan and BPHOGAN.COM.  No reprints without permission 

Exporting Your First Fireworks HTML file 
 
In the upper right corner of your canvas in Fireworks, you will see the Fireworks Logo 
with an arrow .  When you click this, it will bring up the options to export the files for 
use in other programs.  Select the Dreamweaver menu and choose Export HTML. 
 

 
 

Select a folder to save these files. It is not required that you save this to your 
Dreamweaver Site root folder. I suggest saving it to a temporary folder on your desktop. 
 

 
 

Select the options shown above and select the Save button.   
Close your Fireworks document and answer Yes if it asks you to save any changes. 
 
It’s now time to start working in Dreamweaver! 
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Creating the Web Template – Importing Fireworks 
 
This step involves creating a template from a document in Dreamweaver that is 
connected to a Fireworks PNG project file. Dreamweaver will be able to manage all of 
the graphics within your site when you integrate the programs. 

 
Create a new HTML 
document in Dreamweaver 
and make sure that the site 
you created is visible.  
 
Save the document as a 
template by clicking File 
and selecting Save as 
Template. 
 
A new folder should appear 
in your site list, and your 
template should be within 
that folder. 
 
 
 
On the Common tool 

palette, select the Fireworks button . 
 

 
 
Use the Browse button to navigate to your exported Fireworks document. The option 
Delete File after insertion is up to you. I do it because I don’t want any extra copies of 
my template around. When you’re ready, click OK. 
 

 
 

Dreamweaver is smart enough to realize that these image files and JavaScript 
resources are located elsewhere on your hard drive and so will offer you the chance to 
copy these files into your site root folder. You should definitely choose OK when you see 
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this prompt. When you click OK you will be prompted for a location to store your images 
in.  For simplicity’s sake, I chose my default images folder. 

 
After confirming the images folder, the 
page should be imported into 
Dreamweaver! 
 
However, you’ll notice a few strange 
things that need to be addressed. 
First, there’s one section of the page 
that isn’t quite right. We’ll fix that by 
selecting that table cell with our mouse 
and changing it’s background color to 
match the cell above it. We do this by 
clicking the bg button  and use the 
color-picker tool or the eyedropper that 
will appear when the color-picker is 
selected. 
 
  

 
 
 
 
 
 
 
 

 
Once you’ve made the color adjustment, your 
page should now look complete.  The best part 
is that the section you colored will be the 
section of the page that stretches as you add 
more content.  
 
 
Now we need to define our editable regions so 
any pages made with this template can actually 
hold content! 
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Creating the Web Template - Defining Editable Regions 
 

 
 
The Template palette in the Insert toolbar contains the tools you need to define the 
editable regions of your template.  Since this is a short tutorial, I will only use the 
Editable Region  button. 
 
You need to select the section of your web page before pressing the Editable Region 

 button.  For our example, we want to place some text in the main frame of our page. 
Place some text in the main HTML slice as shown and then select it  
 

Click the Editable Region  
button in the Insert palette. This 
will allow you to turn this selection 
into an editable region. It also 
gives you or your coders a visual 
cue as to what type of content will 
go there. 
 
 
You will be presented with a dialog 
asking for the name of the new 

region. Give it a descriptive name 
and click OK.  Take a look at your 
document and see how it has 
changed. 
 
 

 
Now that you’ve got your region 
defined, you can save the 
template. First, though, let’s get 
this ready for prime time. 
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Creating the Web Template – Making It Look Good. 
 
Go to the Modify menu in Dreamweaver and click on the Page Properties button. You 
will see the following dialog there. 
 

 
 
This is where the main properties for the page are set. You can use whatever color 
settings you want, but I strongly suggest that you use the same values as above for the 
Left Margin, Top Margin, Margin Width, and Margin Height. Though these values are 
only supported in IE 4.0 and Netscape 4.0 and greater, it really makes a difference in the 
way your page looks and works, especially if you add a pop-up menu or are using other 
absolute-positioning features. 
 
When you’re done, click OK to save changes and return to the template. 
 
Finally, let’s add a separate navigation menu and a copyright notice to the bottom region 
of our site so that they will be available on all pages. This works great for creating page 
footers. 
 

Uh oh! Something’s wrong. You may notice that the bottom left 
corner of the page is now expanding.  We’ll fix this later. 
 
 

 
 
Save your file to make sure none of your changes are lost. 
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Dreamweaver and Fireworks Integration 
 
Now, after all of that work, it’s time to start using these programs together. Right above 
the Dreamweaver properties palette, you’ll see a horizontal hierarchy of the HTML tags 
that compose your page. 
 

 
 
These are jump points. By clicking on any of these, Dreamweaver will automatically 
highlight that entire block of code, from the starting tag to the closing tag. This works 
great for the step we’re about to do… editing our entire template from within Fireworks. 
 
Select the first <table> tag in the list above the Properties palette. Your view should 
change to something similar to what is shown above.  We are interested in the Src 
section of the above picture. 
 

 Notice the Edit button? That shows us 
that we can edit this table in Fireworks!.  Click on the Edit button. 
 
Whoops! It’s telling us it can’t find the PNG file! You’ll have to locate it yourself. Click 
Browse and then point it to the location of your original PNG file that you saved from 
Fireworks. When you locate it and select it, Dreamweaver will actually pull it into your 
site root folder. Any edits on the PNG file will be saved there. 

 
Here you can make any changes you want to your 
document and images and have them automatically 
imported into your Dreamweaver template.  What’s 
more, the changes should then filter down to any 
pages created from your Dreamweaver template!. 
 
We need to fix one small problem with our template: 
we had that lower-left slice expanding too much.  
 
Convert the lower-left slice from an image slice to an 
HTML slice by selecting the slice and changing the 
type from Image to HTML in the Properties palette. 
 
Notice the DONE button above your canvas? This is 
how you transfer the changes. It will also save the 

PNG file in one simple step. Click Done and watch the changes occur. The lower-left 
corner image has been removed. You can now fill that table cell in with the background 
color to match the rest of the sidebar. 
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The template before changing the color (on the left) and after (on the right). 
 

Now your template looks as expected.  You can now save the template and begin to 
create pages from it.   
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Using the Template to Make Pages 
 
Click File and choose New.  The New Document window appears. Select the Template 
tab and you should now see your template as an option as shown in the screen below. 
 

 
 
Make sure that the Update Page when Template Changes box is selected and press 
the Create button. 

 Your new page will appear. You’ll be able to 
make changes only to the editable regions you 
defined. Everything else will be locked. 
 
As you add content to the MainContent region, 
you may notice that the sidebar you created 
doesn’t quite look right. This is a Dreamweaver 
issue and can be ignored. If you want to preview 
your work in the web browser to make sure that 
everything is working right, press the F12 key. It 
will generate a temporary file so that you can see 
your work. 
 

 
 
You’ll see from the browser that everything is 
working the way it should. 
 
Save your file by going to File and selecting 
Save. The file should then be saved to your 
site.  You can make additional files by repeating 
the same steps. 
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Using the Template to Affect All Pages – Adding a Pop-up menu 
 
Now that you have a page linked to a template, you can alter your template and have 
those changes trickle down to any linked pages. 
 
In this example we will alter our existing template to create a DHTML Popup menu using 
Fireworks. 
 
Open your template file in Dreamweaver and select the main table from the tag list 
above the Properties palette. 
 

 
 
Click the Edit button next to the Src field on the Properties palette. 

  
 
This will open the original Fireworks document and allow us to make our menu. 
 

Right-click on the slice that contains the 
Products menu item and choose Add Popup 
Menu. The wizard will then appear. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The first screen is where your menu items go. The first column holds the text 
descriptions and the second column is for the URLs you wish to associate with the 
descriptions. The third column lets you specify a target browser or frame. 
 
After you have constructed your menu items and URLS, click the Next button. 
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Now we can customize the appearance of the 
menu, by changing the colors, fonts, images, 
and font style. Configure your styles and click 
Next to work with some more advanced 
settings. 
 
 
 
 
 
 
 
 
 
 
 
 
The Advanced tab allows you to specify the 
width and height of the menu items, the 
padding and spacing of the cells that make 
up each item, and other options such as tab 
spacing and the delay. 
 
You also can turn off the menu borders here, 
or control the color of the shadow. 
 
When you’ve customized your menu settings, 
press Next to position your menu on the 
page. 
 
 
 
 
 
The Position tab lets you specify which 
direction the menu item flies out, and even 
how submenus fold out. You can also specify 
the exact X and Y positions of the menu. 
 
Keep in mind that using DHTML menus 
requires that your users have a browser that 
supports them. This means a JavaScript 
enabled browser version 4.0 and higher. It’s 
good practice to create pages containing text 
versions of your menus that are then linked 
from the slice you’ve attached your DHTML 
menu to. That way, non-JavaScript browsers 
can still navigate your site. 
 
Click Done to build the menu. 
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You should now see your menu attached to the 
slice. You can now click the Done button 

 and the changes will 
be saved to the source document and placed into 
your template. 
 
Now, go to the File menu and save your template. 
You will be prompted to update any other files that 
are linked to your template. Click Update to apply 
the changes. You will then be presented with a 
summary of the changes. 
 
 
 

 
When you preview any of your pages in 
the browser, you will see your pages 
with all of the functionality we have 
added using Fireworks. 
 
If you followed the tutorial exactly, your 
main home page should look similar to 
the example at the left. 
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Conclusion 
 
You can use this method to maintain the entire website by only changing the one 
template. It allows you to easily manipulate or modify images, including compression 
types. You also have the ability to quickly make changes to links and navigation through 
your template.  
 
I’ve only covered the very basics.  You still have to make links to all of your pages in 
your site, and you still have lots of options to explore that we haven’t even touched on. 
 
It just keeps getting better and better, doesn’t it? 
 
 


